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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, 
software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any 
losses and damages incurred by you or third parties arising from the use of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims 
involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas 
Electronics products or technical information described in this document, including but not limited to, the product data, drawings, 
charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of 
Renesas Electronics or others. 

4. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas 
Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration, 
modification, copying or reverse engineering. 

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The 
intended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
"Standard": Computers; office equipment; communications equipment; test and measurement equipment; 

audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; 
industrial robots; etc. 

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights);  
large-scale communication equipment; key financial terminal systems; safety control equipment; etc. 

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet 
or other Renesas Electronics document, Renesas Electronics products are not intended or authorized for use in products or 
systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical 
implantations; etc.), or may cause serious property damage (space system; undersea repeaters; nuclear power control systems; 
aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any 
damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent 
with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

6. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, 
“General Notes for Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage 
conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply 
voltage range, heat dissipation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any 
malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified ranges. 

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor 
products have specific characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use 
conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data 
sheet or other Renesas Electronics document, Renesas Electronics products are not subject to radiation resistance design. You 
are responsible for implementing safety measures to guard against the possibility of bodily injury, injury or damage caused by 
fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design 
for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate 
treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is 
very difficult and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you. 

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility 
of each Renesas Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and 
regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and 
using Renesas Electronics products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims 
any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations. 

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose 
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any 
applicable export control laws and regulations promulgated and administered by the governments of any countries asserting 
jurisdiction over the parties or transactions. 

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, 
or otherwise sells or transfers the product to a third party, to notify such third party in advance of the contents and conditions set 
forth in this document. 

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of 
Renesas Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document 
or Renesas Electronics products. 
 
(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly 

or indirectly controlled subsidiaries. 
(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.  

 
(Rev.4.0-1 November 2017)  



How to Use This Manual 
This manual describes how to use how to use features of the Trace Compass from e2 studio for RZ/G board.  
 

Readers  This manual is intended for Renesas MCU developers who wish to understand how to 
use Trace Compass for viewing LTTng trace data with e2 studio. 

 
Purpose  This manual aims to provide user with the explanation of the functions provided in 

Trace Compass and LTTng when they commence the development of their hardware 
and software systems using the targeted devices. 

 
How to Read This Manual  Please read guide and do installation, configuration and debug sequentially. 

 
Conventions       Data significance: Higher digits on the left and lower digits on the right 
 

Note:    Footnote for item marked with Note in the text 
 
Numeric representation:  Decimal ... XXXX 

Hexadecimal ... 0xXXXX 
  



Table of Contents 

1. Introduction ........................................................................................................................................ 5 
1.1 Required Resources ................................................................................................................................................... 5 
1.2 Main Process for create trace project ........................................................................................................................ 6 

2. Set up environment ............................................................................................................................ 7 
2.1 Set up Linux system build server .............................................................................................................................. 7 
2.2 Install e2 studio .......................................................................................................................................................... 7 

3. Create Linux system image with kernel configurations related to LTTng ........................................ 8 
3.1 Create Embedded Linux Custom BSP Project .......................................................................................................... 8 
3.2 Set kernel configurations related with LTTng .......................................................................................................... 8 
3.3 Build Linux system image ........................................................................................................................................ 9 
3.4 Boot target device by Linux system image ............................................................................................................... 9 

4. Environment setting for Trace compass debugging ......................................................................... 10 
4.1 Obtaining Target Board IP Address ........................................................................................................................ 10 
4.2 Set IP Address on PC (Cross Lan cable network only) ........................................................................................... 13 
4.3 Set Remote Host in e2 studio ................................................................................................................................... 15 
4.4 Importing and Generating Trace project ................................................................................................................. 22 

5. Tracing Perspective .......................................................................................................................... 24 
5.1 Colors ...................................................................................................................................................................... 25 
5.2 Histogram ................................................................................................................................................................ 29 
5.3 State System Explorer ............................................................................................................................................. 31 
5.4 Statistics .................................................................................................................................................................. 32 
5.5 Synchronization ...................................................................................................................................................... 33 
5.6 Time Chart .............................................................................................................................................................. 34 

6. LTTng Perspective ........................................................................................................................... 35 
6.1 Control .................................................................................................................................................................... 36 
6.2 Control Flow ........................................................................................................................................................... 36 
6.3 CPU Usage .............................................................................................................................................................. 41 
6.4 Resources ................................................................................................................................................................ 42 
  



Renesas e2 studio                     Trace Compass with LTTng User’s Manual:  

R20UT4479EJ0000  Rev.1.00  Page 5 of 46 
  
 

 

 

1.   Introduction 

Trace Compass is a tool for viewing and analyzing any type of logs or traces. Its goal is to provide views, 
graphs, metrics, etc. to help extract useful information from traces, in a way that is more user-friendly and 
informative than huge text dumps. 

LTTng, stands for the Linux Trace Toolkit: next generation, is an open source software toolkit which you can 
use to simultaneously trace the Linux kernel, user applications, and user libraries. 

This getting started guide describes how to use Trace Compass on Renesas e2 studio with LTTng trace data. 

1.1 Required Resources 

The procedure in this guide applies to RZ/G board. The following resources are required: 
  
• Supported devices (RZ/G Series) 
• A PC running Microsoft® Windows® 7, 8 or 10  
• e2 studio 

Note. Check version information of e2 studio for supporting RZ/G.  
See document named ‘RZ/G Linux Platform Development Environment User’s Manual for the 
Linux Customization Tool, the Verification and Analysis Tools’ that is orderable 
in Renesas Market Place  web page. 

  

https://mp.renesas.com/
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1.2 Main Process for create trace project 

To create a trace project, the following process are required: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Tracing 
Perspective

LTTng 
Perspective

Boot target device by 
Linux system image
with LTTng kernel 

configurations

Set configurations of 
network between
PC & target board

Generate/import
Trace project

Based on obtained target board IP 
address by ‘ifconfig’ command. 
Refer to chapter 4. 

Build Linux system image included 
kernel configurations of LTTng and 
write system image file on SD card. 
Refer to chapter 3. 

Run application and get trace data 
from target board. 
Refer to chapter 5 and 6. 

Figure 1-1 Basic operation 



Renesas e2 studio                     Trace Compass with LTTng User’s Manual:  

R20UT4479EJ0000  Rev.1.00  Page 7 of 46 
  
 

 

 

2. Set up environment  

2.1 Set up Linux system build server 

If you use Renesas Electronics’ RZ/G Linux platform,  

• Set up Linux system build server. You can refer to document named ‘Build Server Setup Manual’ can be 
ordered at ‘Market – Documentation’ in Renesas Market Place web page. If you have problems for setting 
up build server, please contact Renesas electronics via Renesas Market Place.  
 
Note. All descriptions in this document are based on this way. 
 

• Alternatively, refer to https://elinux.org/RZ-G/Boards/Yocto about how to build Linux system image file 
for RZ/G by Host PC. (In this case, you can’t use ‘RZ/G LinuxPF customization’ plug-in for e2 studio.) 

 

2.2 Install e2 studio 

Please refer to document in below list. 

• For installation of e2 studio and common components 
: e2 studio Integrated Development Environment User's Manual: Getting Started Guide chapter 2.1 
 

• For e2 studio’s components installation which are related with RZ/G such as ‘RZ/G LinuxPF 
Customization Tool’ plug-in 
: Please order the document named ‘RZ/G Linux Platform Development Environment User’s Manual 
for the Linux Customization Tool, the Verification and Analysis Tools’ at ‘Market’ – ‘Documentation’ 
in Renesas Market Place web page and see chapter 2. 

 
  

https://mp.renesas.com/
https://mp.renesas.com/
https://elinux.org/RZ-G/Boards/Yocto
https://www.renesas.com/en-us/doc/products/tool/doc/006/r20ut2771ej0400_e2_start_s.pdf
https://www.renesas.com/en-us/doc/products/tool/doc/006/r20ut2771ej0400_e2_start_s.pdf
https://www.renesas.com/en-us/doc/products/tool/doc/006/r20ut2771ej0400_e2_start_s.pdf
https://mp.renesas.com/
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3. Create Linux system image with kernel configurations 
related to LTTng  

3.1 Create Embedded Linux Custom BSP Project 

Startup e2 studio. (For the detail steps about start up e2 studio, please refer to e2 studio Integrated Development 
Environment User's Manual: Getting Started Guide. 

For making Linux system image included kernel configs of LTTng, ‘Embedded Linux Custom BSP 
Project’ is needed for customizing Linux features. See chapter 3.5.2 of the document named ‘RZ/G Linux 
Platform Development Environment User’s Manual for the Linux Customization Tool, the 
Verification and Analysis Tools’ that is orderable in Renesas Market Place  web page. 

 

3.2 Set kernel configurations related with LTTng 

Please check, add and modify Linux kernel configs in below list, are enabled or disabled. And then build Linux 
system image. 

Name Configs y/n 
FTRACE  y 
 FUNCTION_TRACER y 
 TRACEPOINTS y 
 FTRACE_SYSCALLS n 
 FUNCTION_GRAPH_TRACER n 
User defined   
 LTTNG y 
 STAGING y 

Figure 3-1 Linux kernel configs related to LTTng 
 

  

https://www.renesas.com/en-us/doc/products/tool/doc/006/r20ut2771ej0400_e2_start_s.pdf
https://www.renesas.com/en-us/doc/products/tool/doc/006/r20ut2771ej0400_e2_start_s.pdf
https://www.renesas.com/en-us/doc/products/tool/doc/006/r20ut2771ej0400_e2_start_s.pdf
https://www.renesas.com/en-us/doc/products/tool/doc/006/r20ut2771ej0400_e2_start_s.pdf
https://mp.renesas.com/


Renesas e2 studio                     Trace Compass with LTTng User’s Manual:  

R20UT4479EJ0000  Rev.1.00  Page 9 of 46 
  
 

 

 

Please refer to chapter 3.12 of the document named ‘RZ/G Linux Platform Development Environment 
User’s Manual for the Linux Customization Tool, the Verification and Analysis Tools’ to do the settings, 
and set the configurations as per below picture: 

 

Figure 3-2 Modify kernel configs: Linux kernel configs related to LTTng 
 

3.3 Build Linux system image 

After setting kernel configuration for enabling LTTng, build Linux system image for SD card. (See chapter 3.8 
of document named ‘RZ/G Linux Platform Development Environment User’s Manual for the Linux 
Customization Tool, the Verification and Analysis Tools’) 
 

3.4 Boot target device by Linux system image 

After building Linux system image for SD card, download and write Linux system image to SD card (See 
chapter 3.9 and 3.10 of document named ‘RZ/G Linux Platform Development Environment User’s Manual 
for the Linux Customization Tool, the Verification and Analysis Tools’) and boot target device by SD card. 
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4.Environment setting for Trace compass debugging 
 

4.1 Obtaining Target Board IP Address 

(1) Remove the SD card from PC and insert it into card slot of upper layer on the target board. 

(2) Provide power through ‘POWER JACK’, then: 

a. Use USB type-b cable to connect between PC and target board ‘DEBUG PORT’. 

b. Use cross LAN cable to connect between PC and target board ‘ETHERNET-1 USB HOST’ port. 
(See Chapter 4.2) 

c. Or use LAN cable to connect between Router, which is connected to PC, and target board 
‘ETHERNET-1 USB HOST’ port. (Skip Chapter 4.2) 

 

 

Figure 4-1 Port location 

(3) Click [Open Terminal] button in e2 studio menu, and do the following settings in the pop-up window: 

Choose terminal: Serial Terminal 
Bit/sec: 115200  
Data bit: 8   
Parity: none  
Stop bit: 1   
Flow control: none 
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 Then click [OK] to open the terminal. 

 

Figure 4-2 Launch terminal setting 

 

(4) In [Terminal] tab, ‘iwg22m login: Using Wayland-EGL’ information should be shown. 

Note: if this information is not shown, please power off the board, then power on the board. 

 

Figure 4-3 Open terminal  
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(5) In [Terminal] tab, enter ‘root’ to login. 

 

Figure 4-4 Login in terminal 

 

(6) In [Terminal] tab, enter ‘ifconfig’ to get the target board IP address, e.g.: 169.254.88.131 (each board 
should have a fixed IP address which may not be the same as this address). 

Note: if this information is not shown, please wait for a few minutes, and type ‘ifconfig’ again. 

 

Figure 4-5 Get the target board IP address  
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4.2 Set IP Address on PC (Cross Lan cable network only) 

Do this step when host PC and target board are connected via LAN cable. If connected via router, skip 
this chapter. 
 

(1) In Windows 10 OS environment, under [Network & Internet] setting,  

a. Click [Proxy] to open setup page. 
b. Ensure that [Manual proxy setup] is set to off. 

 

 

Figure 4-6 Setting IP address on PC 

  

(a) 
(b) 
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(2) Under [Network & Internet] setting: 

a. Click [Ethernet] to open setup page. 
b. Click [Change adapter option]. 
c. In the pop-up window, right click the ‘Ethernet’ and select [Properties]. 

 

 

Figure 4-7 Setting IP address on PC: Network device’s Properties 

(3) In the pop-up window: 

a.  Select [Internet Protocol Version 4 (TCP/IPv4)]. 
b. Click [Properties]. 

 

 

Figure 4-8 Setting IP address on PC: TCP/IPv4  

(a) (b) 

(c) 

(a) 

(b) 
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(4) In the pop-up window: 

a. Select button for [Use the following IP address] and set the following: 
IP address: (e.g.: 169.254.88.131) 
Subnet mask:  255.255.255.0 (It may differ by network environment.) 

b. Select button for [Use the following DNS server address]. 
c. Click [OK] for confirm the settings for the TCP/IPv4 properties.  

 

 

Figure 4-9 Setting IP address on PC: IP address, Subnet mask 

 

4.3 Set Remote Host in e2 studio 

(1) Select [Windows] >[Perspective] > [Open Perspective] > [Other…]. 

Select [LTTng Kernel] and press [OK]. 

 

Figure 4-10 Open perspective: LTTng Kernel 

  

(a) 

(b) 

(c) 
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(2) In ‘Control’ tab, Click [New Connection...]. 

 

Figure 4-11 New Connection... 

(3) Select [SSH] and Click [Create...]. 

 

Figure 4-12 Create connection via SSH 

 

(4) Connection name: Remote Host 

Host: (e.g.: 169.254.88.131) 

User: root (RZ/G default. If you set another user account ID, input that.) 

Select ‘Password based authentication’ 

Password: Input password if you set password of user account. 
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Then click [Finish] 

 

 

Figure 4-13 Edit Connection 

(5) ’Connecting to host failed’ message is shown when running connection at first but click OK. 

 

Figure 4-14 Problem occurred window 

(6) In control view, connection you made is shown, click [Remote Host] first, then click [Connect] 
button. 

 

Figure 4-15 Control view: Connect button 
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(7) [Provider] node and [Sessions] node will appear if connection is successful. 

 

Figure 4-16 Control view: Connected status 

(8) Traceable events list will appear when expanding [Kernel] node. 

 

Figure 4-17 Control view: Kernel API list 

 

(9) Right click on [Sessions] then select [Create Session…]. 

 

Figure 4-18 Control view: Create Session 
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(10) Enter name on [Session Name] text box (e.g. MySession01), click [OK]. 

 

Figure 4-19 Create session: Input session name 

(11) Right click [MySession01], select [Enable Channel...]. 

 

Figure 4-20 Enable channel 
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(12) Write name on [Channel Name] (e.g. MyChannel01). Click [OK]. 

 

Figure 4-21 Enable channel: Input channel name 

 

(13) Right click [MyChannel01], select [Enable Event]. 

 

Figure 4-22 Enable Event 

  



Renesas e2 studio                     Trace Compass with LTTng User’s Manual:  

R20UT4479EJ0000  Rev.1.00  Page 21 of 46 
  
 

 

 

(14) Tick [All] check box. Click [OK]. 

 

Figure 4-23 Enable Event: Select Tracepoint Events 

 

(15) Select [MySession01] node. Click [Start]. 

 

Figure 4-24 MySession01: Start 
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(16) After a while, click [Stop]. 

 

Figure 4-25 MySession01: Stop 

 

4.4 Importing and Generating Trace project 

(1) Click [Import]. 

 

Figure 4-26 MySession01: Import to trace project 
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(2) Select data for importing, Click [Finish]. 

 

Figure 4-27 Remote traces: Select Remote Host, Session 

 

(3) New Trace Project is generated, and data from the target board is enabled to watch in 
[Project Explorer] view. 

The Project Explorer shows Tracing project with a small "T" decorator in the upper right of the 
project folder icon. 

 

Figure 4-28 Trace project in Project Explorer 
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5.   Tracing Perspective 

Tracing Perspective can be opened from [Window] → [Show view] → [Other…] → [Tracing] but some view is 
not shown at default views location. If you need to see all tracing views, 

(1) Go to [Window] → [Show view] → [Other…]. 
 

 
Figure 5-1 Open view: Other… 

 

(2) Under Tracing folder, click shift + [Call Stack] to [Time Chart] to open all the view under ‘Tracing’ 
folder. 

 

 
Figure 5-2 Open view: Select all views in Tracing category 
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5.1 Colors  

The Colors view allows user to define a prioritized list of color settings. 

A color setting associates a foreground and a background color (used in any events table), and a tick color (used 
in the Time Chart view), with an event filter. 

(1) Click [Insert new color settings] button to add colors settings. 

 

Figure 5-3 Colors view 

(2) New color row will be shown in ‘colors view’ tab. 

[FG], [BG] is the color setting for ‘event table’, [Text] is the previews for setting of [FG], [BG] 

[Tick] is the color setting for ‘Time Chart View, [       ] is the previews for setting of [Tick] 

[Filter]: If the event matches multiple filters, the color setting with the highest priority will be used. 

Click each button to set colors, for example: 

[FG]: black 

[BG]: gray 

[Tick]: gray 

 

 

Figure 5-4 Set foreground color 
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(3) Click [Filter] button to set apply conditions. 

In the pop out [Editor filter] window, right click to select the operate object, for example: 
[TRACETYPE]. 

 

Figure 5-5 Editor filter: Add operation 

(4) Select corresponding trace type. Here, we use kernel and select: 

Type: Common Trace Format: Linux Kernel Trace 

 

Figure 5-6 Editor filter: Select trace type 
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(5) Colors views allow user to set multi-color rules and manage them by using [up] [down] to set the 
priority. 

Based on step (1) to (4), add one more color setting, and set the configuration as following: 

[FG]: black 

[BG]: Green 

[Tick]: Green 

[Filter]: [Contains] 

      Type: [common] 

      Aspect: Event type 

      Value: (e.g.: kemem_cache_alloc) 

 

Figure 5-7 Editor filter example: Show event contained ‘kmem_cache_alloc’ 

(6) The colors setting ‘gray background text color, gray tick color’ were shown corresponding in 
[Event table] and [Time Chart View]. 

Note that the green color setting is not shown, use [up] and [down] button, to adjust its priority. 

 

Figure 5-8 Color setting effects shown in various view  
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(7) After changing the priority or the color settings, the color in [event table] and [Time Chart View] 
will change accordingly. 

 

Figure 5-9 Color setting effects shown in various view 

(8) You could use [Export] and [Import] button to export or import the color settings. 

 

Figure 5-3 Export color settings 
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5.2 Histogram 

The Histogram View displays the trace events distribution with respect to time. When streaming a trace, this 
view is dynamically updated as the events are received. 

(1) Histogram has 2 graph views: 

• Bottom side graph is the full histogram on whole timeline. 

• Upper side graph is the section histogram on partial timeline. 

 

On the top left, there are three text controls: 

• Selection Start: Display the start time of the current selection. 

• Selection End: Display the end time of the current selection.  

• Window Span: Display the current zoom window size in seconds. 

 

Figure 5-4 Histogram view 

(2) User could set any two of the settings, [Selection Start], [Selection End] and [Window Span]. 

E.g.:   click        button to disable the [Selection End]. 

[selection Start]: 21:16:00:000 000 000 

         [Window Spam]: 020.000 000 000 

The partial timeline histogram will update accordingly: start from ‘21:15:50,000 000 000’ 
to ’21:16:10,000 000 000’. 

 

Figure 5-5  Histogram view: Select partial timeline  
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(3) In full histogram, left click + drag to set a selection range, the time range selected for histogram will 
change accordingly. 

 

Figure 5-6 Histogram view: Change selected timeline 

 

(4) The Align Views toggle        button in the view menu allows to disable and enable the automatic 
time axis alignment of time-based views. Disabling the alignment in the Histogram view will 
disable this feature across all the views because it's a workspace preference.  

The Hide Lost Events toggle        button in the local toolbar allows to hide the bars of lost events. 
When the button is selected, it can be toggled again to show the lost events.  

The Activate Trace Coloring toggle       button in the local toolbar allows to use separate colors for 
each trace of an experiment. Note that this feature is not available if your experiment contains more 
than twenty-two traces. When activated, a legend is displayed at the bottom on the histogram view. 

 

Figure 5-7 Histogram view: Align with CPU Usage view 
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(5) Hovering the mouse over a histogram bar pops up an information window that displays the start/end 
time of the corresponding bar, as well as the number of events (and lost events) it represents. If the 
mouse is over the selection range, the selection span in seconds is displayed. 

 

Figure 5-8 Pop up an information window 

 

5.3 State System Explorer 

The State System Explorer view allows user to inspect the state interval values of every attribute of a state 
system at specific time. 

The view shows a tree of currently selected traces and their registered state system IDs. For each state system 
the tree structure of attributes is displayed. The attribute name, quark, value, start and end time, and full attribute 
path are shown for each attribute. 

View time start from: 21:12:40. 

 

Figure 5-9  State System Explorer 
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To modify the time of attributes shown in the view, select a different current time in other views that support 
time synchronization (e.g. event table, histogram view). When a time range is selected, this view uses the begin 
time. 

E.g., After selecting a different time in event table, the view time start from 21:16:01. 

 

Figure 5-17 State System Explorer 

 

5.4 Statistics 

The Statistics View displays the various event counters that are collected when analyzing a trace. After opening 
a trace, the data is organized per trace. 

This view shows 3 columns: Level, Events total and Events in selected time range. 

 

Figure 5-18 Statistics view 

  



Renesas e2 studio                     Trace Compass with LTTng User’s Manual:  

R20UT4479EJ0000  Rev.1.00  Page 33 of 46 
  
 

 

 

5.5 Synchronization 

It is possible to synchronize traces from different machines so that they have the same time reference. Events 
from the reference trace will have the same timestamps as usual, but the events from traces synchronized with 
the first one will have their timestamps transformed according to the formula obtained after synchronization. 

 

In order to synchronize traces, create a new experiment and select all traces that need to be synchronized. Right-
click on the experiment and select Synchronize traces. For each trace whose time needs to be transformed, a 
new trace named as the original but followed by a '_' will be created with the transformed timestamps, and the 
original trace will be replaced in the experiment. The original trace can still be accessed under the Traces 
folder. 

 

Note that two opened instances of the same trace are never time synchronized with each other, regardless of the 
toggle option. 

 

Figure 5-19 Add traces to Synchronize Traces 

Information on the quality of the synchronization, the timestamp transformation formula and some 
synchronization statistics can be visualized in the Synchronization view. 

 

Figure 5-10 Synchronization view 
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5.6 Time Chart 

The Time Chart view allows user to visualize every open trace in a common time chart. Each trace is displayed 
in its own row and ticks are displayed for every punctual event.  

As user zooms using the mouse wheel or by right-clicking and dragging in the time scale, more detailed event 
data is computed from the traces.  

The tick colour could be changed as per preference, see setting at chapter 3.2 colour view. 

 

The Align Views toggle button        in the view menu allows to disable and enable the automatic time axis 
alignment of time-based views.  

 

Figure 5-11 Time Chart view 
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6.  LTTng Perspective 

LTTng perspective can be opened from [Window] → [Show view] → [Other…] → [LTTng kernel] but some 
view is not shown at default views location. If you need to see LTTng views, 

(1) Go to [Window] → [Show view] → [Other…]. 
 

 
Figure 6-1 Show view 

(2) Click LTTng folder and select view you want. 
 

 
Figure 6-2 LTTng views 
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6.1 Control  

The LTTng Tracer Control in e2 studio for the LTTng Tracer toolchain (org.eclipse.tracecompass.lttng2) is done 
using SSH and requires an SSH server to be running on the remote host. 

Please refer to chapter 4.3 for the setting of Remote host. 

 

Figure 6-3 Control view 

6.2 Control Flow  

The Control Flow view is a LTTng-specific view that shows per-process events graphically. 

After opening the trace, the element Control Flow is added under the Linux Kernel Analysis tree element in the 
Project Explorer. To open the view, double-click the Control Flow tree element. 

Alternatively, select Control Flow under LTTng within the ‘Show View’ under ‘Window’ (Window → Show 
View → Other...): 

 

Figure 6-4  Control Flow   
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The view is divided into the following important sections: process tree and information, control flow and the 
toolbar. The time axis is aligned with other views that support automatic time axis alignment. 

 

 

Figure 6-5 Control Flow view: Process tree, control flow and toolbar 

(1) Process tree and information: Processes are organized as a tree within this view. This way, child 
and parent processes are easy to identify. 

A given process may be shown at different places within the tree since the nodes are unique (TID, 
birth time) couples.  

The TID column shows the process node's thread ID and the PTID column shows its parent thread 
ID (nothing is shown if the process has no parent).  

 

Figure 6-6 Control Flow view: Detail information of processes  
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(2) Click [Filter] button to open filter window. 

Untick the checkbox of ‘kthreadd’, then click [OK]. 

The process window will update accordingly: process for ‘int’ still viewable, while process 
‘kthread’ disappear in the process tab. 

 

Figure 6-7 Control Flow view: Set filter 

(3) The colored bars you see represent states for the associated process node. When a process state 
changes in time, so does the color.  

 

Figure 6-8 Control Flow view: Set color 
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(4) You'll notice small dots over the colored bars at some places: 

Those dots mean the underlying region is incomplete: there's not enough pixels to view all the 
events. In other words, you need to zoom in.  

(5) When zooming in, small dots start to disappear when no dots are left, you are viewing all the 
events and states within that region.  

 

Figure 6-9 Control Flow view: Small dots in bars 

 

(6) Use [Zoom In], [Zoom Out] button and [Reset the time scale to the Default] to set the time scale. 

 

Figure 6-10 Control Flow view: [Zoom In], [Zoom Out] button 
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(7) Click following button to go to each process: 

Button Description Button Description 

 

 
select previous event 

 

 
select next event 

 

 
select previous process 

 

 
select next process 

 

 
Follow CPU backward 

 

 
Follow CPU forward 

 

Figure 6-11 Control Flow view: Tool bar 

 

(8) Hover the cursor over a colored bar and a tooltip will pop up： 

The tooltip indicates: 

•the process name 

•the pointed state name 

•the CPU (if applicable) 

•the system call name (if applicable) 

•the pointed state date and start/stop times 

•the pointed state duration (seconds) 

 

Figure 6-12 Control Flow view: Hover to pop up information  
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6.3 CPU Usage 

The view is divided into the following important sections: Process Information and the CPU Usage Chart.  

The time axis is aligned with other views that support automatic time axis alignment. 

 

Figure 6-13 CPU Usage view 

The CPU Usage Chart on the right side of the view plots the total time spent on all CPUs of all processes and 
the time of the selected process. 

Hover the cursor over a line of the chart and a tooltip will pop up with the following information: 

time: current time of mouse position  

Total: The total CPU usage 

 

Figure 6-14 Hover to pop up information  
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6.4 Resources 

This view shows the state of system resources.  

The left side of the view presents a list of resources that are affected by at least one event of the trace. The right 
side illustrates the state in which each resource is at some point in time.  

 

Figure 6-105 Resource view 

(1) Click following button to go to each process:  

Button Description Button Description 

 

 
select previous event 

 

 
select next event 

 

 
select previous resource 

 

 
select next resource 

 

Figure 6-16 Resource view toolbar 

(2) Hover the cursor over a colored bar and a tooltip will pop up: 

Trace, state, date, start time, stop time, duration 

 

Figure 6-11 Resource view  
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